
NOTIFICACIÓN

 4635/2022Expediente nº:
Notificación al Interesado

 Asistencia y AsesoramientoProcedimiento:
 Geonet Territorial, SauInteresado:

 30/03/2022Fecha de iniciación:

EXPEDIENTE
Nº

ÓRGANO FECHA Nº
DECRETO

4635/2022 Diputado de Carreteras, Vías,
Conservación de Edificios e
Instalaciones y Parque Móvil (OM)

12/08
/2022

2022-
3375

Por Resolución, se ha dispuesto lo siguiente:

HECHOS Y FUNDAMENTOS DE DERECHO

ASUNTO: Encomienda de gestión para el servicio de Estudio para la
identificación de caminos de dominio público de la provincia de Alicante.

Visto el expediente relativo a la tramitación de una Encomienda de
gestión a la sociedad GEONET TERRITORIAL S.A.U. para llevar a cabo un
“ESTUDIO PARA LA IDENTIFICACIÓN DE CAMINOS DE DOMINIO PÚBLICO
DE LA PROVINCIA DE ALICANTE”, y de conformidad con el informe
emitido por la Jefa del Servicio Económico-Administrativo de fecha 29 de
julio de 2022, así como la fiscalización favorable del gasto efectuada por
la Intervención de Fondos Provincial con fecha 5 de agosto de 2022, en
virtud de las facultades que me fueron delegadas por Resolución del Ilmo.
Sr. Presidente núm. 2985, de fecha 26 de julio de 2019 (BOP núm. 145,
de fecha 1 de agosto de 2019), vengo en disponer:

Vista la propuesta de resolución PR/2022/1342 de 8 de agosto de 2022.

RESOLUCIÓN
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PRIMERO.- Aprobar LAS TARIFAS fijadas en la Claúsula 8ª del  “PLIEGO
DE CONDICIONES TÉCNICAS PARA LA REALIZACIÓN DEL ESTUDIO PARA
LA IDENTIFICACIÓN DE CAMINOS DE DOMINIO PÚBLICO DE LA
PROVINCIA DE ALICANTE”, cuyo contenido es el siguiente:

“El presupuesto máximo asignado al proyecto es de 50.000,00 € y se
imputará a la partida 34.4541.2270601 del presupuesto vigente
denominada “Estudio de Identificación de Caminos de Dominio Público en
la provincia de Alicante”.

La facturación de los trabajos se realizará en tres pagos, el primero
coincidirá con la finalización de las Fases I a V, por importe de 12.510,00
€, el segundo pago se realizará una vez terminada la Fase VI, por
importe de 34.950,00 € y el último pago, por importe de 2.090,00 €,
tendrá lugar a la finalización de los trabajos correspondientes a las Fases
VII y VIII, así como con la entrega del CD conteniendo el fichero con los
resultados alfanuméricos georreferenciados en formato Geopackage
(GPKG)”.

Se formalizará un acta de recepción de los trabajos que suscribirá el
representante de la empresa encargada de la realización de los trabajos,
o persona en quien delegue, la Jefa de la Unidad de Gestión de la
Información Geográfica e Infraestructuras del Departamento de
Carreteras y el representante que disponga el Departamento de
Intervención a los efectos de la comprobación material de la Inversión.

SEGUNDO.- Aprobar el “PLIEGO DE CONDICIONES TÉCNICAS PARA LA
REALIZACIÓN DEL ESTUDIO PARA LA IDENTIFICACIÓN DE CAMINOS DE
DOMINIO PÚBLICO DE LA PROVINCIA DE ALICANTE” que regirá el
encargo realizado por la Excma. Diputación Provincial de Alicante a favor
de la empresa provincial GEONET TERRITORIAL S.A.U., cuyo tenor literal
se transcribe a continuación:

““PLIEGO DE CONDICIONES TÉCNICAS PARA LA REALIZACIÓN DEL
ESTUDIO PARA LA IDENTIFICACIÓN DE CAMINOS DE DOMINIO PÚBLICO
DE LA PROVINCIA DE ALICANTE.”

1.- ANTECEDENTES.
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De acuerdo al artículo 4 de la Ley 6/1991, de 27 de marzo, de Carreteras
de la Comunidad Valenciana, el Sistema Viario de la Comunidad
Valenciana está integrado por:

Red de Carreteras del Estado.

Red Básica de la Comunidad Valenciana.

Red Local de la Comunidad Valenciana.

Red de Caminos de Dominio Público de la Comunidad Valenciana,
compuesta por todas las vías de titularidad pública no incluidas en los
apartados anteriores, susceptibles de tránsito rodado.

Según el artículo 9, la titularidad de los caminos de dominio público podrá
corresponder tanto a las Entidades Locales en cuyos términos municipales
se encuentren ubicados, como a las demás administraciones y
organismos públicos.

Corresponde a los titulares de los Caminos de Dominio Público, su
ejecución, gestión, conservación, explotación y señalización, tal y como
indica el artículo 13.

Problemática actual.

Existe en la provincia un importante número de caminos con tráficos
intensos y de elevado interés viario. Esta extensa red de caminos tendría
una longitud estimada de 25.000 km.  La longitud de los caminos
recogida en el Inventario Provincial de Infraestructuras y Encuesta de
Infraestructuras y Equipamientos Locales, EIEL anualidad 2016 asciende
a 5.000 km.

Los recursos municipales destinados a su mantenimiento son
insuficientes, motivo por el que la Diputación Provincial de Alicante tiene
establecidas unas líneas de ayudas para la mejora de su conservación.
Con el fin de planificar y optimizar estas inversiones se hace necesario
disponer de información actualizada de la red de caminos que contemple
datos como su localización, identificación y catalogación.

La recogida de información relativa a los caminos reviste interés por
diversos motivos, no solo para la planificación de obras e inversiones. Al
ser el carácter público de los caminos desconocido en muchos casos, se
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produce su abandono y apropiación por parte de particulares. Por esta
razón, su catalogación permitiría recuperar este importante patrimonio.

Por otro lado, la provincia de Alicante cuenta con numerosos parajes
naturales a los que se accede a través de caminos, motivo por el que
también sería interesante localizarlos con el objetivo de promocionarlos
como caminos de interés paisajístico, turístico o medioambiental.

(VER ANEXO I – MAPA CAMINOS PROVINCIA ALICANTE)

Estos distintos intereses sobre la red de caminos se traducen en una
gestión independiente de los mismos desde varias Áreas de la Diputación,
motivo por el que la información se encuentra dispersa y es poco
accesible.

Solución propuesta.

El establecimiento de un SIG de caminos como elemento centralizador de
la información, aseguraría la existencia de una única fuente de datos,
común a todos los departamentos, que mejoraría su integridad y calidad,
así como su gestión y difusión.

Los datos se recogerían una sola vez, evitando duplicidades, optimizando
los procesos y rentabilizando las inversiones. Las áreas con intereses
comunes que podrían participar en el proyecto son: Infraestructuras,
Planes de Obras Municipales, Asistencia a Municipios e incluso Medio
Ambiente.

2.- OBJETO DE LOS TRABAJOS.

El estudio tendrá por objeto la identificación y georreferenciación de los
caminos de titularidad pública de la Provincia de Alicante, constituyendo
la primera fase del Proyecto “Sistema de Información Geográfica de la
Red de Caminos públicos de la Provincia de Alicante”.

3.- DESCRIPCIÓN DE LOS TRABAJOS A REALIZAR.

En cuanto a las tareas a desarrollar, básicamente, estas consistirán en el
estudio de las distintas fuentes de información geográfica que incluyan
redes de comunicación, de tal forma que se identifiquen aquellas que se
encuentren catalogadas como caminos, para tras su análisis, obtener
información relativa a su geometría y características.
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Una vez identificados y georreferenciados los caminos, se añadirá en la
base de datos geográfica, información alfanumérica descriptiva de los
mismos. Finalmente, se procederá a la publicación y difusión de la
información recabada a través del cliente SIG Web ligero GeoGIS para su
consulta.

La unidad de trabajo será el municipio, con el fin de adaptarse a la
delimitación territorial del catastro.

Las fuentes de información a partir de las cuales se puede extraer
información sobre la geometría y características de los caminos serían las
siguientes:

Servicios INSPIRE. Red de Transporte. Red viaria.

Cartografía oficial de la Comunitad Valenciana a escala 1:5.000 ICV.

Nomenclátor Toponímico Valenciano.

Dirección General del Catastro.

Encuesta de Infraestructuras y Equipamientos Locales, EIEL.

Libros de Inventario Municipales.

Datos sobre inversiones Diputación Provincial de Alicante.

Los trabajos se desarrollarán a través de las siguientes fases:

FASE 1: ALCANCE, PLANIFICACIÓN Y EVALUACIÓN DE
NECESIDADES.       

1.1    Revisar Información Inicial Disponible.

Identificación de las fuentes de información disponible y estado, tanto
espacial como meramente alfanumérica susceptible de incorporar al
“Sistema de Información Geográfica de la Red de Caminos públicos de la
Provincia de Alicante”.

1.2    Reuniones con partes implicadas.

Organización de reuniones iniciales con las partes implicadas.

1.3    Definir alcance y objetivos.
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Identificar necesidades. Establecer el alcance, fases y objetivos del
proyecto.  establecer con claridad el alcance y objetivos para esta FASE
2022. Identificar necesidades de las partes implicadas: Requerimientos
de los usuarios, casos de uso, nivel de difusión de la información.

1.4    Preparar Planificación Detallada.

Preparación de la Planificación de la FASE 1 conforme el alcance y
objetivos del proyecto.

1.5    Establecer Calendario de Trabajos.

Definición calendario de trabajo de la FASE 1 con asignación de recursos
conforme a los plazos establecidos en la planificación y objetivos.

FASE 2: EVALUAR / RECOPILAR INFORMACIÓN Y DOCUMENTACIÓN
DISPONIBLE.        

2.1    Estudiar Fuentes de Datos Primarias disponibles.  

Organismo propietario de los datos, temática, formato ficheros, Sistema
de Referencia, disponibilidad, escalas de representación, fecha de
producción, copyright.

2.2    Estudiar Fuentes de Datos Secundarias disponibles .

Formatos, Sistema de Referencia, fecha, disponibilidad, estado de
conservación, escalas de representación, calidad del dato, posibles
duplicidades de información, estructura ficheros vectoriales...etc.

FASE 3: DISEÑO DEL REPOSITORIO DE DATOS Y CONFIGURACIÓN DEL
SISTEMA.                

3.1    Diseñar y Crear Prototipo de la solución.     

Diseño de la Base de Datos Relacional de tipo Espacial a implementar
sobre SGBD para almacenar la información cartográfica y alfanumérica en
un repositorio centralizado. Contiene información espacial facilitada, así
como la información alfanumérica susceptible de ser incorporada.
Estructurada conforme al modelo Entidad-Relación.

3.2    Definir roles de usuario y herramientas de validación.
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Definición de los perfiles y roles de usuario. Acceso a capas de
información y capacidades de acceso, edición y borrado de la misma.

3.3    Desplegar sistema y Repositorio de Datos.

Puesta en funcionamiento del Repositorio de Datos en entorno de
producción.

FASE 4: INTEGRACIÓN DE FUENTES DATOS PRIMARIOS.         

Aquellos procedentes de entidades públicas productoras de Información
Geográfica que se pueden emplear en la FASE 2022  del SIG de Caminos
a nivel provincial y, en su forma original, ya son susceptibles de ser
sometidos a las operaciones de manejo y análisis que incorporan los SIG.
(Formatos digitales estándar, ficheros georreferenciados con SGR
conocido, metadatos, información asociada para facilitar su interpretación:

 Red de Transportes (Instituto Geográfico Nacional)

 Ejes Carreteras y Catálogo CEGESEV (Generalitat Valenciana)

 Nomenclátor Toponímico de la Comunidad Valenciana (ICV)

 Cartografía Catastral (Dirección General del Catastro)

  Titulares Catastrales (Dirección General del Catastro)

  EIEL (Diputación de Alicante)

  Modelo Digital del Terreno (IGN, ICV)

  Ortofotos serie histórica (IGN, ICV, Geonet)

4.1    Geocodificación Directa.

Asignación de coordenadas espaciales a ficheros digitales de texto plano
con datos puntuales o localizaciones implícitas correctamente
estructuradas.

4.2    Conversión de Formato de Datos.      

Conversión de Información Geográfica Georreferenciada en formato
digital. Puede ser "Transitiva" o "No Transitiva". Incluye conversión de
Raster -> Vector y Vector -> Raster.
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4.3    Reducción de Datos (Raster/Vector). 

Reducción del espacio en disco de los datos y los tiempos de procesado.
Incluye filtrado de datos de interés y simplificación de datos en formato
vector y raster, así como migración de datos alfanuméricos contenidos en
BBDD de modelo no relacional a modelo relacional siempre y cuando
estos contengan la información adecuadamente estructurada.

4.4    Interpolación.       

"Creación datos espaciados regularmente a partir de datos irregulares.
Estimación de valores para localizaciones sin datos en base a valores
conocidos y al comportamiento espacial del fenómeno (Modelos Digitales
de Elevaciones, Modelos Digitales de Superficies, Superficies de
Tendencia).

4.5    Carga en Repositorio de Datos.

Carga de IG depurada  e información alfanumérica tabulada en Base de
Datos Espacial. Incluye la generación de tablas intermedias, tablas vista
predefinidas y demás operaciones de gestión dela BD (indexado,
restricciones, perfiles de usuario...etc).

FASE 5: INTEGRACIÓN DE FUENTES DE DATOS SECUNDARIOS.       

Derivan de algún otro tipo de dato previo, el cual no es adecuado para su
empleo directo en un SIG. Precisan tratamiento independizado para su
explotación en el SIG:

Inventarios municipales de caminos

Inventarios municipales

Actuaciones mantenimiento caminos / carreteras (Diputación de Alicante)

Catastro Histórico (Avances Catastrales, Mapa Topográfico Parcelario)

 Minutas Cartográficas (IGN)

5.1    Geocodificación - OCR +  Fichero.

Asignación de coordenadas espaciales a ficheros de texto con datos
puntuales de Localizaciones Implícitas o Nubes de Puntos que requieran
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trabajo de edición posterior al no poder geocodificarse directamente el
archivo resultante.

5.2    Conversión de Medios de Datos – Digitalización.

Requiere escaneo previo del documento. En ocasiones dado el estado de
conservación del original habrá que implementar operaciones de realce
de imagen. Puede implicar digitalización manual o automática
dependiendo de las características del dato original.

5.3    Conversión de Formato de Datos.      

Conversión de Información Geográfica previamente Georreferenciada y
transformada a formato digital. Puede ser "Transitiva" o "No Transitiva".
Incluye conversión de Raster -> Vector y Vector -> Raster. La calidad del
dato puede condicionar los tiempos, así como la viabilidad de la
conversión.

5.4    Reducción de Datos (Raster/Vector)  

Reducción del espacio en disco de la IG y los tiempos de procesado.
Incluye simplificación de datos en formato vector y raster.

5.5    Reducción de Datos (Alfanumérica desestructurada / BD No
Relacional -> BD Relacional).

Extracción y tratamiento de la información alfanumérica susceptible de
ser incorporada a la BD. Procedente tanto de las cartelas de los planos
como de documentos de tipo texto. Incluye conversión de la misma a
formato tabular para su carga en las tablas correspondientes de la BD.

5.6    Topología y Errores.

Depuración topológica, corrección de errores conforme tolerancias y
conciliación de información de las diferentes fuentes para evitar
discrepancias espaciales.

5.7    Georreferenciación - Transformación Homogénea.

Georreferenciación de planos habitualmente escaneados que no
presentan deformación, en buen estado y de los que se conocen las
coordenadas de la hoja.
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5.8    Georreferenciación - Transformación Diferencial.

Georreferenciación planos habitualmente escaneados que por su estado
de conservación o presentar deformaciones requieren una corrección
diferencial.

5.9    Encaje de Bordes – Raster.

Generación mosaicos a partir de imágenes georreferenciadas.

5.10  Encaje de Bordes – Vectorial.

Generación cartografía vectorial continua.

5.11  Ajuste de Imágenes Raster - Collar Removal, Image Balancing.

Generación de mosaicos de imágenes raster mediante el solapamiento de
imágenes adyacentes, la supresión de información marginal y el ajuste
radiométricos de los datos.

5.12  Fusión / Agregación.      

Recopilación datos. Generación IG derivada a partir de datos secundarios
previamente procesados mediante operaciones espaciales o de cruce.
Requiere en numerosas ocasiones tratamientos previos de
georreferenciación, reducción de datos, Topología, subsanación de
discrepancias entre fuentes.

5.13  Carga en Repositorio de Datos.

Carga de IG depurada e información alfanumérica tabulada en Base de
Datos Espacial. Incluye la generación de tablas intermedias, tablas vista
predefinidas y demás operaciones de gestión dela BD (indexado,
restricciones, perfiles de usuario...etc).

FASE 6: ANÁLISIS.

Análisis de la documentación cartográfica integrada en el SIG para la
identificación de caminos, digitalización del trazado e inserción de datos:
titularidad y pavimentación. Asignación de componente 3D a la red de
caminos a partir de Modelo Digital del Terreno.

6.1    Modelado Espacial.
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Diseño y ejecución de modelos de análisis espacial para la revisión
masiva de titularidades o el cotejo con el Catálogo de Carreteras.
Asignación de componente 3D a la red de caminos a partir de Modelo
Digital del Terreno.

6.2    Digitalización del trazado de caminos existentes a partir de la red
de transportes del IGN.

Análisis del trazado de caminos y sendas a partir de la documentación
cartográfica y literal existente. Trazado según geometría de la red de
transporte.

6.3    Agregación información alfanumérica.

Recopilación datos a partir de las diversas fuentes de datos. Incluye
operaciones de análisis espacial y/o de cruce de datos alfanuméricos.
Revisión ocular de fotografías aéreas, de actuaciones mantenimiento
caminos en Proyectos Diputación. Información ofrecida por técnicos
municipales. Inventarios.

Datos a incorporar:

Denominación oficial

Titular catastral

Término municipal

Código (un código por término municipal)

Inicio y Final

Referencias Catastrales de los tramos

Términos municipales que atraviesa

Coincidencia con vía pecuaria SI/NO

Nombre de la vía pecuaria

6.4    Carga en Repositorio de Datos.
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Carga de IG resultado de análisis en Base de Datos Espacial. Incluye las
operaciones de gestión de la BD (indexado, restricciones, perfiles de
usuario...etc.)

FASE 7: PUBLICACIÓN Y DIFUSIÓN DE LA INFORMACIÓN
GEOGRÁFICA.        

Publicación, consulta y actualización de la información integrada en la
FASE 2022 del SIG de Caminos. Online a través del cliente SIG Web
ligero GeoGIS, como a través de software SIG de escritorio QGIS para
usuarios habilitados    

7.1    Personalización plataforma GeoGIS.  

Creación Geoportal de acceso y personalización de la solución SIG
conforme a las necesidades de la Diputación (logotipo, carga
predeterminada de capas, herramientas predefinidas...).

7.2    Configuración y Carga información Repositorio de Datos en
plataforma GeoGIS.    

Publicación de IG de la BD en la plataforma GeoGIS. Incluye: a.
Asignacion de roles de usuario y permisos de edición, b. definición de
estilos, c.extracción e incorporación enlaces url en capas a
documentación.

7.3    Instalación y configuración solución SIG escritorio QGIS.

Instalación y configuración del acceso al repositorio de datos desde la
solución SIG de escritorio QGIS en los equipos del cliente, en caso de ser
necesario.

FASE 8: CIERRE DE PROYECTO Y REMISIÓN.                 

8.1    Redacción de documentación final Proyecto.

Redacción documentación final del proyecto. Documentación de la
metodología empleada, fuentes y recursos tenidos en cuenta, marco
normativo y problemas encontrados. Incluyendo estructura de la solución
y manuales de usuario.

8.2    Formación usuarios.       
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Formación a técnicos (curso básico 6h para cada perfil de usuario
ampliable según requerimientos).

4.- DOCUMENTACIÓN A ENTREGAR.

Se deberá entregar a los Servicios Técnicos del Departamento de
Carreteras de la Diputación Provincial de Alicante una copia de toda la
información producida y utilizada a lo largo del proyecto acorde con la
metodología contenida en apartado tres del presente pliego de
prescripciones técnicas.

A la finalización del proyecto, se deberá aportar un CD que contenga un
fichero con los resultados alfanuméricos georreferenciados en formato
Geopackage (GPKG).

5.- EQUIPO DE TRABAJO.

La empresa encargada de la realización de los trabajos se compromete a
adscribir a la ejecución del proyecto, los medios personales con la
formación y experiencia necesaria y recursos materiales suficientes para
su correcta realización.

6.- DURACIÓN Y PLAZO DE EJECUCIÓN.

Los trabajos se iniciarán con la firma del contrato, finalizando con su
entrega, estableciéndose como fecha máxima para la misma, el 30 de
noviembre de 2022.

7.- PLAZO DE GARANTÍA.

Se establece un plazo de doce meses de garantía, a contar desde la
entrega y aceptación de los trabajos, durante el cual deberán resolverse
todas aquellas deficiencias que a criterio de la Diputación hayan sido
detectadas.

8. - FIJACIÓN DE LAS TARIFAS Y FORMA DE PAGO.

El presupuesto máximo asignado al proyecto es de 50.000 € y se
imputará a la partida 34.4541.2270601 “Estudio de identificación de
caminos de dominio público en la Provincia de Alicante” del vigente
presupuesto 2022 de la Diputación Provincial.
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A continuación, se detallan las fases del proyecto junto con la relación de
tareas a realizar, así como las horas de trabajo estimadas y el coste de
los miembros del equipo de trabajo, que asumirán tres roles: Gestor
Proyecto, Analista SIG y Analista Informático, tomando como precio base
de la hora de trabajo, respectivamente, 40 €, 30 € y 30 €.

FASE 1: Alcance, Planificación y Evaluación de Necesidades, 680 €

FASE 2: Evaluar-Recopilar Información y Documentación Disponible, 840
€

FASE 3: Diseño del Repositorio de Datos, configuración del Sistema,
1.330 €

FASE 4: Integración de Fuentes Datos primarios, 1.710 €   

FASE 5: Integración de Fuentes de Datos secundarios, 7.950 €

FASE 6: Análisis, 34.950 €

FASE 7: Publicación y Difusión de la Información Geográfica, 1.230 €

FASE 8: Cierre de Proyecto y Remisión, 860 €

Total, 49.550,00 €

(VER ANEXO II – TABLA FASES Y TAREAS PROYECTO)

8.1. Facturación del servicio:

La facturación de los trabajos se realizará en tres pagos, el primero
coincidirá con la finalización de las Fases I a V, por importe de 12.510,00
€, el segundo pago se realizará una vez terminada la Fase VI, por
importe de 34.950,00 € y el último pago, por importe de 2.090,00 €,
tendrá lugar a la finalización de los trabajos correspondientes a las Fases
VII y VIII, así como con la entrega del CD conteniendo el fichero con los
resultados alfanuméricos georreferenciados en formato Geopackage
(GPKG).

El abono de los trabajos será mediante facturas conformadas en relación
a los trabajos realmente ejecutados según, los precios unitarios que
figuran en el apartado 8 del presente Pliego.
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El contratista expedirá las facturas a cargo de la Diputación Provincial de
Alicante (CIF: P0300000G), y las presentará mediante factura electrónica
a través del Punto General de Entrada de Facturas Electrónicas.

En atención a ello las facturas se ajustarán al formato estructurado de la
factura electrónica “Facturae, versión 3.2” y se suscribirán mediante
firma electrónica conforme a la especificación “XMLAdvanced Electronic
Signatures (XAdES)” presentándose a través de Punto General de
Entrada de Facturas Electrónicas denominado FACE en https://face.gob.es
/   con indicación para cada factura de la OFICINA CONTABLE, el ORGANO
GESTOR y la UNIDAD TRAMITADORA cuyos códigos se indican a
continuación:

OFICINA CONTABLE ORGANO GESTOR UNIDAD
TRAMITADORA

LA0002926-
INTERVENCIÓN

LA0002926-
INTERVENCIÓN

LA0003236-
CARRETERAS

La recepción de la factura en el punto general de entrada de facturas
electrónicas FACE y su anotación en el registro contable de facturas le
dará validez para su tramitación y pago en los plazos establecidos en la
normativa vigente.

9.- SUBCONTRATACIÓN.

La empresa encargada de la realización del proyecto objeto de este pliego
de condiciones técnicas, realizará con sus propios medios los trabajos sin
recurrir a la subcontratación de los mismos.

10.- REGLAS ESPECIALES RESPECTO DEL PERSONAL LABORAL DE LA
EMPRESA CONTRATISTA.

Siguiendo la Instrucción nº 4/2013, aprobada por Decreto de la
Presidenta núm. 1398, de fecha 7 de agosto de 2013, se dispone que:

1. Corresponde exclusivamente a la empresa encargada de la realización
de los trabajos la selección del personal que, reuniendo los requisitos de
titulación y experiencia exigidos en el pliego, si así se requiriera, formará
parte del equipo de trabajo adscrito a la ejecución del contrato, sin
perjuicio de la verificación por parte de la “entidad contratante” del
cumplimiento de aquellos requisitos.
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2. La empresa encargada de la realización de los trabajos asume la
obligación de ejercer de modo real, efectivo y continuo, sobre el personal
integrante del equipo de trabajo encargado de la ejecución del contrato,
el poder de dirección inherente a todo empresario.

En particular, asumirá la negociación y pago de los salarios, la concesión
de permisos, licencias y vacaciones, las sustituciones de los trabajadores
en casos de baja o ausencia, las obligaciones legales en materia de
Seguridad Social, incluido el abono de cotizaciones y el pago de
prestaciones, cuando proceda, las obligaciones legales en materia de
prevención de riesgos laborales, el ejercicio de la potestad disciplinaria,
así como cuantos derechos y obligaciones se deriven de la relación
contractual entre empleado y empleador.

3. La empresa encargada de la realización de los trabajos velará
especialmente porque los trabajadores adscritos a la ejecución del
contrato desarrollen su actividad sin extralimitarse en las funciones
desempeñadas respecto de la actividad delimitada en los pliegos como
objeto del contrato.

4. La empresa encargada de la realización de los trabajos estará obligada
a ejecutar el contrato en sus propias dependencias o instalaciones salvo
que, excepcionalmente, sea autorizada a prestar sus servicios en las
dependencias de la Diputación de Alicante. En este caso, el personal de la
empresa contratista ocupará espacios de trabajo diferenciados del que
ocupan los empleados públicos. Corresponde también a la empresa
contratista velar por el cumplimiento de esta obligación. En el pliego
deberá hacerse constar motivadamente la necesidad de que, para la
ejecución del contrato, los servicios se presten en las dependencias de la
Diputación de Alicante.

5. La empresa encargada de la realización de los trabajos designar al
menos un coordinador técnico o responsable, integrado en su propia
plantilla, que tendrá entre sus obligaciones las siguientes:

a) Actuar como interlocutor de la empresa contratista frente a la “entidad
contratante”, canalizando la comunicación entre la empresa contratista y
el personal integrante del equipo de trabajo adscrito al contrato, de un
lado, y de la “entidad contratante”, de otro lado, en todo lo relativo a
cuestiones derivadas de la ejecución del contrato.
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b) Distribuir el trabajo entre el personal encargado de la ejecución del
contrato, e impartir a dichos trabajadores las órdenes e instrucciones de
trabajo que sean necesarias en relación con la prestación del servicio
contratado.

c) Supervisar el correcto desempeño por parte del personal integrante del
equipo de trabajo de las funciones que tienen encomendadas, así como
controlar la asistencia de dicho personal al puesto de trabajo.

d) Organizar el régimen de vacaciones del personal adscrito a la
ejecución del contrato, debiendo a tal efecto coordinarse adecuadamente
la empresa contratista con la “entidad contratante”, a efectos de no
alterar el buen funcionamiento del servicio.

e) Informar a la “entidad contratante” acerca de las variaciones,
ocasionales o permanentes, en la composición del equipo de trabajo
adscrito a la ejecución del contrato.

11. - PROPIEDAD INTELECTUAL Y EXPLOTACIÓN.

Todos los documentos y resultados de los trabajos realizados serán
propiedad de la Diputación Provincial de Alicante, pudiendo ésta realizar
la reproducción total, parcial, distribución, divulgación, transformación de
los productos obtenidos y comunicación pública. El adjudicatario sólo
podrá hacer uso de estos, ya sea como referencia o como base de futuros
trabajos, siempre que cuente con la autorización expresa de la Diputación
Provincial de Alicante.

12. - CONFIDENCIALIDAD DE LA INFORMACIÓN Y SEGURIDAD.

La empresa objeto del encargo, y el personal encargado de la realización
de las tareas, guardarán secreto profesional sobre los hechos,
informaciones, conocimientos, documentos, y asuntos a los que tengan
acceso o conocimiento durante la vigencia del contrato, estando
obligados a no dar publicidad o enajenar cuantos datos conozcan como
consecuencia o con ocasión de su ejecución, incluso después de finalizar
el plazo contractual. En el caso de que la empresa objeto del encargo, en
el ejercicio de la prestación del servicio, tuviera que manejar ficheros con
datos de carácter personal en el marco del objeto del presente encargo,
cumplirá con las obligaciones en materia de protección de datos de
carácter personal conforme a la legalidad vigente.
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La Diputación se reserva el derecho de efectuar en cualquier momento
los controles y auditorías que estime oportunos para comprobar el
correcto cumplimiento por parte de la empresa objeto del encargo de la
realización de sus obligaciones, la cual está obligada a facilitarles cuantos
datos o documentos le requiera para ello.

13. - DIRECCIÓN DE LOS TRABAJOS.

La dirección de los trabajos se llevará a cabo por la Jefa de la Unidad de
Gestión de la Información Geográfica e Infraestructuras del
Departamento de Carreteras, quien podrá delegar estas funciones, en
todo o en parte, en otros técnicos del Servicio. Corresponde a la dirección
la supervisión de la entrega de los inventarios actualizados, dar
conformidad a la facturación de los trabajos realizados, así como resolver
cualquier duda e interpretación que pueda surgir en la realización del
trabajo.

14. – RESPONSABILIDADES.

La empresa adjudicataria será responsable de la calidad técnica de los
trabajos realizados, así como de las consecuencias que se deduzcan para
la Diputación o para terceros por omisiones, errores o métodos
inadecuados en la ejecución de la prestación y durante el plazo de
garantía de éste.”

TERCERO.- Encargar a la empresa provincial GEONET TERRITORIAL S.A.
U., los trabajos consistentes en la “REALIZACIÓN DEL ESTUDIO PARA LA
IDENTIFICACIÓN DE CAMINOS DE DOMINIO PÚBLICO DE LA PROVINCIA
DE ALICANTE”, de conformidad con lo establecido en el artículo 32,
apartados 2, 6 y 7 de la Ley 9/2017, de 8 de noviembre, de Contratos del
Sector Público, por la que se transponen al ordenamiento jurídico español
las Directivas del Parlamento Europeo y del Consejo 2014/23/UE y 2014
/24/UE, de 26 de febrero de 2014.

CUARTO.- Autorizar y disponer un gasto a favor de GEONET
TERRITORIAL S.A.U, por importe de CUARENTA Y NUEVE MIL
QUINIENTOS CINCUENTA EUROS (49.550,00 €.-) con imputación a la
aplicación presupuestaria 34.4541.2270601 del presupuesto vigente
denominada ‘Estudio de Identificación de Caminos de Dominio Público en
la provincia de Alicante’.
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QUINTO.- Los pagos se efectuarán mediante certificación expedida por
cualquiera de los responsables de la Dirección Técnica nombrada por esta
Diputación sobre la base de la relación valorada de los trabajos realmente
ejecutados, al que se acompañará informe favorable emitido por el
responsable del contrato así como la correspondiente factura emitida por
la empresa GEONET TERRITORIAL S.A.U, acreditativa de la realización de
cada uno de los trabajos, debiéndose acompañar a la última de dichas
facturas además, el acta de entrega y recepción.

SEXTO.- Designar como titular de la Dirección Técnica para el
seguimiento de los trabajos del encargo anteriormente indicado, a la
funcionaria de carrera adscrita al Área de Servicios e Infraestructuras de
la Excma. Diputación Provincial de Alicante Dña. María Paz Sotodosos
Alarcón con D.N.I. 4.591.904T, Ingeniera topógrafo, que desempeña el
puesto de Jefa de Gestión de la Información geográfica e
Infraestructuras, como responsable del seguimiento y validación de los
trabajos del encargo.

SÉPTIMO.- Formalizar el encargo en un documento que incluya el plazo
de duración del encargo y publicar dicho documento en la Plataforma de
Contratación Pública del Estado conforme a lo establecido en los artículos
32.6 y 63.6 de la Ley 9/2017, de 8 de noviembre, de Contratos del
Sector Público, por la que se transponen al ordenamiento jurídico español
las Directivas del Parlamento Europeo y del Consejo 2014/23/UE y 2014
/24/UE, de 26 de febrero de 2014.

OCTAVO.- Publicar el contenido de la encomienda en el portal de
transparencia en cumplimiento de lo exigido por el artículo 9.1 a) de la
Ley 2/2015, de 2 de abril, de Transparencia, Buen Gobierno y
Participación Ciudadana de la Comunitat Valenciana, y el artículo 9.1 b)
de la Ordenanza de transparencia y acceso a la información de la Excma.
Diputación Provincial de Alicante.

NOVENO.- Notificar la presente resolución a la empresa provincial
GEONET TERRITORIAL S.A. a los oportunos efectos.

RECURSOS/ALEGACIONES

Contra la presente Resolución, que pone fin a la vía administrativa, podrá
interponerse potestativamente, en base a los artículos 123 y 124 de la
Ley 39/2015, de 1 de octubre, del Procedimiento Administrativo Común
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de las Administraciones Públicas, recurso de reposición en el plazo de un
mes desde la recepción de la notificación ante el órgano autor del acto, o
bien directamente recurso contencioso-administrativo en el plazo de dos
meses contados de la misma forma, a tenor de lo previsto en el artículo
46 de la Ley 29/1998, de 13 de julio, reguladora de la Jurisdicción
Contencioso-Administrativa, advirtiendo que tales recursos no suspenden
la ejecución del acto notificado. Sin perjuicio de lo anterior, se podrá
ejercitar cualquier otro recurso que se estime procedente.

DOCUMENTO FIRMADO ELECTRÓNICAMENTE
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ANEXO I – MAPA CAMINOS PROVINCIA ALICANTE 
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ANEXO II – TABLA FASES Y TAREAS PROYECTO 

 

Gestor 
Proyecto 

Analista 
SIG 

Técnico 
Cartografía 

Analista 
Informático 

Técnico 
Sistemas TOTAL TRABAJO FASE 

40,00 € 30,00 € 30,00 € 30,00 € 30,00 € 

          Horas Coste   

17 0 0 0 0 17 680,00 € FASE I 

0 28 0 0 0 28 840,00 € FASE II 

1 26 0 10 7 44 1.330,00 € FASE III 

0 30 27 0 0 57 1.710,00 € FASE IV 

0 42 223 0 0 265 7.950,00 € FASE V 

0 58 1100 0 7 1165 34.950,00 € FASE VI 

0 7 7 20 7 41 1.230,00 € FASE VII 

2 26 0 0 0 28 860,00 € FASE VIII 

20 217 1357 30 21 1645 49.550,00 € TOTALES 

 

FASE 1: Alcance, Planificación y Evaluación de Necesidades 
 

1.1 Revisar Información Inicial Disponible 

  Identificación de las fuentes de información disponible y estado, tanto espacial 

como meramente alfanumérica susceptible de incorporar al SIG DE CAMINOS 

1.2 Reuniones con partes implicadas 
  Organización de reuniones iniciales con las partes implicadas. 

1.3 Definir alcance y objetivos. Identificar necesidades 

  

Establecer el alcance y objetivos del proyecto. Si este se va a organizar en fases 

anuales con objetivos específicos para cada fase, establecer con claridad el 

alcance y objetivos para esta FASE 2022. Identificar necesidades de las partes 

implicadas: Requerimientos de los usuarios, casos de uso, nivel de difusión de la 

información 

1.4 Preparar Planificación Detallada 

  Preparación de la Planificación de la FASE 1 conforme el alcance y objetivos del 

proyecto 

1.5 Establecer Calendario de Trabajos 

  Definición calendario de trabajo de la FASE 1 con asignación de recursos conforme 

a los plazos establecidos en la planificación y objetivos 

 

FASE 2: Evaluar / Recopilar Información y Documentación Disponible 

 
2.1 Estudiar Fuentes de Datos Primarias disponibles 

  
Organismo propietario de los datos, temática, formato ficheros, Sistema de 

Referencia, disponibilidad, escalas de representación, fecha de producción, 

copyright... 

2.2 Estudiar Fuentes de Datos Secundarias disponibles 
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Formatos, Sistema de Referencia, fecha, disponibilidad, estado de conservación, 

escalas de representación, calidad del dato, posibles duplicidades de información, 

estructura ficheros vectoriales...etc. 

 

FASE 3: Diseño del Repositorio de Datos y Configuración del Sistema 

 
3.1 Diseñar y Crear Prototipo de la solución 

  

Diseño de la Base de Datos Relacional de tipo Espacial a implementar sobre SGBD 

para almacenar la información cartográfica y alfanumérica en un repositorio 

centralizado. Contiene información espacial facilitada, así como la información 

alfanumérica susceptible de ser incorporada. Estructurada conforme al modelo 

Entidad-Relación. 

3.2 Definir roles de usuario y herramientas de validación 

  Definición de los perfiles y roles de usuario. Acceso a capas de información y 

capacidades de acceso, edición y borrado de la misma. 

3.3 Desplegar sistema y Repositorio de Datos 
  Puesta en funcionamiento del Repositorio de Datos en entorno de producción 

   

 

FASE 4: Integración de Fuentes Datos PRIMARIOS 

Aquellos procedentes de entidades públicas productoras de Información Geográfica que 

se pueden emplear en la FASE 2022 del SIG de Caminos a nivel provincial y, en su 

forma original, ya son susceptibles de ser sometidos a las operaciones de manejo y 

análisis que incorporan los SIG. (Formatos digitales estándar, ficheros 

georreferenciados con SGR conocido, metadatos, información asociada para facilitar su 

interpretación...) 

 

- Red de Transportes (Instituto Geográfico Nacional) 

- Ejes Carreteras y Catálogo CEGESEV (Generalitat Valenciana) 

- Nomenclátor Toponímico de la Comunidad Valenciana (ICV) 

- Cartografía Catastral (Dirección General del Catastro) 

- Titulares Catastrales (Dirección General del Catastro) 

- EIEL (Diputación de Alicante) 

- Modelo Digital del Terreno (IGN, ICV) 

- Ortofotos serie histórica (IGN, ICV, Geonet) 

4.1 Geocodificación Directa 

  Asignación de coordenadas espaciales a ficheros digitales de texto plano con 

datos puntuales o localizaciones implícitas correctamente estructuradas 

4.2 Conversión de Formato de Datos 

  
Conversión de Información Geográfica Georreferenciada en formato digital. 

Puede ser "Transitiva" o "No Transitiva". Incluye conversión de Raster -> Vector 

y Vector -> Raster 

4.3 Reducción de Datos (Raster/Vector) 

  

Reducción del espacio en disco de los datos y los tiempos de procesado. Incluye 

filtrado de datos de interés y simplificación de datos en formato vector y raster 

así como migración de datos alfanuméricos contenidos en BBDD de modelo no 

relacional a modelo relacional siempre y cuando estos contengan la información 

adecuadamente estructurada. 

4.4 Interpolación 

  Creación datos espaciados regularmente a partir de datos irregulares.  

Estimación de valores para localizaciones sin datos en base a valores  
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conocidos y al comportamiento espacial del fenómeno (Modelos Digitales de 

Elevaciones, Modelos Digitales de Superficies, Superficies de Tendencia...) 

4.5 Carga en Repositorio de Datos 

 

 

Carga de IG depurada e información alfanumérica tabulada en Base de Datos 

Espacial. Incluye la generación de tablas intermedias, tablas vista predefinidas y 

demás operaciones de gestión dela BD (indexado, restricciones, perfiles de 

usuario...etc) 

 

FASE 5: Integración de Fuentes de Datos SECUNDARIOS 

Derivan de algún otro tipo de dato previo, el cual no es adecuado para su empleo 

directo en un SIG. Precisan tratamiento independizado para su explotación en el SIG 

5.1 Geocodificación - OCR + Fichero 

  
Asignación de coordenadas espaciales a ficheros de texto con datos puntuales 

de Localizaciones Implícitas o Nubes de Puntos que requieran trabajo de edición 

posterior al no poder geocodificarse directamente el archivo resultante. 

5.2 Conversión de Medios de Datos - Digitalización 

  

Requiere escaneo previo del documento. En ocasiones dado el estado de 

conservación del original habrá que implementar operaciones de realce de 

imagen. Puede implicar digitalización manual o automática dependiendo de las 

características del dato original 

5.3 Conversión de Formato de Datos 

  

Conversión de Información Geográfica previamente Georreferenciada y 

transformada a formato digital. Puede ser "Transitiva" o "No Transitiva". Incluye 

conversión de Raster -> Vector y Vector -> Raster. La calidad del dato puede 

condicionar los tiempos así como la viabilidad de la conversión. 

5.4 Reducción de Datos (Raster/Vector) 

  Reducción del espacio en disco de la IG y los tiempo de procesado. Incluye 

simplificación de datos en formato vector y raster. 

5.5 
Reducción de Datos (Alfanumérica desestructurada / BD No Relacional -> BD 

Relacional) 

  

Extracción y tratamiento de la información alfanumérica susceptible de ser 

incorporada a la BD. Procedente tanto de las cartelas de los planos como de 

documentos de tipo texto. Incluye conversión de la misma a formato tabular 

para su carga en las tablas correspondientes de la BD 

5.6 Topología y Errores 

  Depuración topológica, corrección de errores conforme tolerancias y conciliación 

de información de las diferentes fuentes para evitar discrepancias espaciales. 

5.7 Georreferenciación - Transformación Homogénea 

  Georreferenciación de planos habitualmente escaneados que no presentan 

deformación, en buen estado y de los que se conocen las coordenadas de la hoja 

5.8 Georreferenciación - Transformación Diferencial 

  Georreferenciación planos habitualmente escaneados que por su estado de 

conservación o presentar deformaciones requieren una corrección diferencial 

5.9 Encaje de Bordes - Raster 
  Generación mosaicos a partir de imágenes georreferenciadas 

5.10 Encaje de Bordes - Vectorial 
  Generación cartografía vectorial continua 

5.11 Ajuste de Imágenes Raster - Collar Removal, Image Balancing 

  
Generación de mosaicos de imágenes raster mediante el solapamiento de 

imágenes adyacentes, la supresión de información marginal y el ajuste 

radiométricos de los datos 
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5.12 Fusión / Agregación 

  

Recopilación datos. Generación IG derivada a partir de datos secundarios 

previamente procesados mediante operaciones espaciales o de cruce. Requiere 

en numerosas ocasiones tratamientos previos de georreferenciación, reducción 

de datos, Topología, subsanación de discrepancias entre fuentes...etc. 

5.13 Carga en Repositorio de Datos 

  

Carga de IG depurada e información alfanumérica tabulada en Base de  

Datos Espacial. Incluye la generación de tablas intermedias, tablas  

vista predefinidas y demás operaciones de gestión dela BD (indexado,  

restricciones, perfiles de usuario...etc.) 

 

FASE 6: Análisis 

Análisis de la documentación cartográfica integrada en el SIG para la identificación 

de caminos, digitalización del trazado e inserción de datos: titularidad y 

pavimentación. Asignación de componente 3D a la red de caminos a partir de Modelo 

Digital del Terreno. 

6.1 Modelado Espacial 

  
Diseño y ejecución de modelos de análisis espacial para la revisión masiva de 

titularidades o el cotejo con el Catálogo de Carreteras. Asignación de 

componente 3D a la red de caminos a partir de Modelo Digital del Terreno. 

6.2 
Digitalización del trazado de caminos existentes a partir de la red de transportes 

del IGN. 

  
Análisis del trazado de caminos y sendas a partir de la documentación 

cartográfica y literal existente. Trazado según geometría de la red de 

transporte. 

6.3 Agregación información alfanumérica 

  

Recopilación datos a partir de las diversas fuentes de datos. Incluye 

operaciones de análisis espacial y/o de cruce de datos alfanuméricos. Revisión 

ocular de fotografías aéreas, de actuaciones mantenimiento caminos -

Proyectos Diputación. Información ofrecida por técnicos municipales. 

Inventarios. 

 

6.4 Carga en Repositorio de Datos 

 

 

Carga de IG resultado de análisis en Base de Datos Espacial. Incluye las 

operaciones de gestión de la BD (indexado, restricciones, perfiles de 

usuario...etc.) 

 

FASE 7: Publicación y Difusión de la IG 

Publicación, consulta y actualización de la información integrada en la FASE 2022 

del SIG de Caminos. Online a través del cliente SIG Web ligero GeoGIS, como a 

través de software SIG de escritorio QGIS para usuarios habilitados 

7.1 Personalización plataforma GeoGIS 

  
Creación Geoportal de acceso y personalización de la solución SIG conforme a 

las necesidades de la Diputación (logotipo, carga predeterminada de capas, 

herramientas predefinidas...) 

7.2 Configuración y Carga información Repositorio de Datos en plataforma GeoGIS 

  
Publicación de IG de la BD en la plataforma GeoGIS. Incluye: a.Asignacion de 

roles de usuario y permisos de edición, b. definición de estilos, c.extracción e 

incorporación enlaces url en capas a documentación 

7.3 Instalación y configuración solución SIG escritorio QGIS 

  Instalación y configuración del acceso al repositorio de datos desde la solución 

SIG de escritorio QGIS en los equipos del cliente, en caso de ser necesario 
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FASE 8: Cierre de Proyecto y Remisión 
   

8.1 Redacción de documentación final Proyecto 

  
Redacción documentación final del proyecto. Documentación de la metodología 

empleada, fuentes y recursos tenidos en cuenta, marco normativo y problemas 

encontrados. Incluyendo estructura de la solución y manuales de usuario 

8.2 Formación usuarios 

  Formación a técnicos (curso básico 6h para cada perfil de usuario ampliable 

según requerimientos) 
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